
Intro To Excel Spreadsheet for use in Introductory Sciences 
INTRO TO EXCEL (with Sea Floor Spreading) 

Objectives: 
¾ Learn about the physical environment near the Mid-Atlantic ridge and Sea floor Spreading 
¾ Become familiar with the Excel spreadsheet environment. (Parts 1-5) 
¾ Learn to create and save a worksheet. (Part 1) 
¾ Perform simple calculations, copy formulas, fill, and edit (part 2) 
¾ Relative vs. fixed references (part 2) 
¾ Graphing Equations and Formatting text and graphs (part 2 and 3a, 3b, and 3c) 
¾ Learn to import data into Excel spreadsheet. (part 4) [parts 4&5 are in separate document] 
¾ Learn to make a graph of spreadsheet data and to compare data with model.   (part 5) 
 
Most of the activity will have you actually use the Excel Environment and work through examples 

but if you are completely unfamiliar with the spreadsheet concept and utility, the link below is a good 
reference.  There is some good information at this site that will not be covered very well in the rest of 
the assignment.  http://www.usd.edu/trio/tut/excel/  However if you have a little idea of what Excel is 
about you should be able to work through these activities without any trouble.  The reference above still 
might be of use to you sometime in your future 

Part 1:  Opening Excel and creating your first worksheet  
 In this section, the text that you actually type in will appear as bold faced and pressing the 
return or enter key is indicated by [R], which can usually be done with a click on the OK button in a 
dialog box or using the arrows up, down, right, or left.  If you’re using a Mac the command key is 
typically used when the control key [Ctrl] is designated for the PC. 
 
Load the Excel program by double clicking on the Microsoft Excel icon or selecting it from programs on 
the start menu.  Ask for help if you can’t find it, or use the find file command (on start menu for PC or 
Finder on Mac) to find it. 

        
   

An empty worksheet should appear on your screen.  If you are using a different version of Excel, the 
menu bar may not look exactly like the one shown below; this should not be a problem for this 
introductory tutorial. 
 

 
 
First enter some labels in cells A2-A4. 
Select cell A2 by pointing on the cell A2 and clicking once. 
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  Type in Name:  [R] 
The pointer is now in cell A3. 
  Type in Date:  [R]      and then      Type in Assignment:  [R]   for cell A4 
 
 We use the shorthand notation below for the somewhat verbose instructions above to make 
this instruction guide easier to follow. 
 A2:  Name: 
 A3:  Date:  
 A4:  Assignment: 
Note:  the return key is not explicitly included in our shorthand notation but should be pressed.   
 
You may want to change the column width if your entries are too long for the default widths.  You can 
do this by clicking on the A at the top of column A to select the whole column and then either: 
move the cursor to the line between A and B, and 
then click and drag the width to a new size 
Easiest way for one column. 

 
Or go to the Format menu, click with the mouse, 
drag down to the column, select width, and change 
the width value to a new width.  Format - Column 
– Width box is our short hand in this activity. 
This is great if you want to select several columns 
at once and make them all the same width.  

In cells B2 - B4 enter your name, date, and Sea Floor Spreading I for the assignment. 
 
For practice, save your new worksheet to your disk or to a temporary space on your hard drive using the 
File-Save As command.  To use this command, point to the File menu name in the menu bar, press and 
hold the mouse button, then drag through the items in the menu until the Save As command is 
highlighted.  Releasing the mouse button when Save As is highlighted selects this command.  This short 
hand notation File-Save As command will be used for other commands throughout this activity. 
 A dialog box will appear that has book1 highlighted. 

¾ Type in the name for your file.  Be 
creative, but use a name that will 
remind you what's in your file. 

¾ Click on the Drop Down menu and 
navigate to the location where you 
want to save your work.  Don’t 
forget where it is. 

¾ Click on the save button (or press 
return). 

 
If you save this Excel document to a removable disk you can take it with you or if you save it on the hard disk you can e-mail 
it to yourself as an attachment provided you have e-mail service and an internet connection. 

  
 
Part 2.  Doing simple calculations with Excel. 
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 In this assignment we are going to create a table of values for the depth of the ocean floor as a 
function of distance from the Mid- Atlantic-Ridge (MAR).  The derivation of the equation that we’ll use 
is outlined in http://topex.ucsd.edu/geodynamics/07cooling.pdf but is not our focus here.    

w=-[ D* + C sqrt(10|X|/ u) ] 
Here w is the depth from the surface of the ocean to the ocean floor, X is the horizontal distance from 
the ridge measured in meters and u is the sea floor spreading rate in km/Myr, C= 0.11 is a dimensionless 
constant that depends on the densities and temperatures of the mantle and ocean, and D* is the depth of 
the ridge center(in km).  We won’t fool around with the value of C just yet and will assume it to be 
constant. 
 
We assume that we know D*,  and U from measurements and will use this analytical model to calculate 
w for different values of X.  Later we’ll use this table to make a graph of the ocean floor depth (w) vs. 
horizontal distance from the ridge (on x-axis). 
 In cells A6 - A8 enter: 
  A6:  Depth of ridge 
  A7:  constant 
  A8:  spreading rate 
In cells B6 - B8 enter: 

  B6:  D* =  
  B7:  C  = 
  B8:  u = 

In cells C6 - C8 enter: 
  C6:  =2.5 
  C7:  =0.11 
  C8:  =50.0 
(the equal signs for C6, C7, & C8 are important) 
Let's format the labels in cells B6-B8 to spiff up 
their appearance.  Select cells  B6 - B8 by:  
pointing on B6, pressing and holding the mouse 
button, dragging the pointer to cell B8.**  (B6 - 
B8 should now be highlighted.) 
— Select  Format-Cells- Alignment tab and 
on the horizontal drop down select right. 
— This action right justifies your labels.  
Easier yet would be to simply click on the right 

justify icon on the tool bar.    This may be 
hidden in the drop down format menu on the far 
right of the tool bar. 
  

** This action will be referred to as click on B6 
and drag to B8 or simply Select Cells B6-B8 

 
The nice thing about the Excel environment is that when you set the mouse pointer on top of a 

toolbar icon a text box appears describing what that icon does.  For example, clicking the disk icon 
(third from left) gives you a quick save of your work and acts like the save-as when you are saving a 
document for the first time.      
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Click on the box labeled [B] in the tool bar to make your labels in B6-B8 bold. [they are still selected?] 

     
Make the labels in cell A2 - A4 Bold by following the same procedure as above (select and click on [B] 

icon).  Select cells C6 - C8 and left justify these cells using the left justify icon  
 
OOPS!  We made a mistake.  We forgot to put units on the labels in cells B6 - B8.  Units are always 
very important. Although Excel can only do calculations with numerical values, indicating the units for 
these values is important so that the numbers make sense.   No problem, we'll do it now. 
Select cell B6. 
 
Position the cursor between the * and = sign of the 
formula bar at the very top of the screen and click.  
Now type  (km) then [R].  This should give you       
D*(km)=       in cell B6 
 

 

 
In the same way include units for  B8. 
 
 
Use the Format-  Cell - Number command and 
then Number, set Decimal places to 2 [R] or click 
okay to set the values of cells C6 - C8 to numbers 
with two digits to the right of the decimal point.  If 
for some reason you wanted to format the cells to 
have one (or three or whatever) digits to the left of 
the decimal place you could do that also. 

 
 
In cells B10 & C10, enter: 
 B10:  Distance, X (km) 
 C10:  Depth, w (km) 
 

Make these labels bold and align them in the center with center alignment.  
 
Here’s a sample problem that we’ll solve using the Excel environment. 
Given that the MAR depth is 2.5 km below the surface, the sea floor spreading rate is 50 km/Myr, What 
is the depth of the ocean floor at a horizontal distance of 2000 km from the MAR? 
 
Enter B11: =-2000 as the first X distance.  We will then use excel to put this distance into our formula to 
calculated the ocean depth at this location.  (we take –2000 km to be west and +2000 km to be east but 
since our formula has the absolute value we get the same answer for either value.) 
 
Here we show the Excel equation and then right below we show the corresponding terms of the analytic 
formula. 
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Enter c11:  =  -  (     c$6    + c$7  *   sqrt   (10  *  abs($B11)  /  c$8)  )  [R] (again make sure to include 
the = sign) Also you do not need to include the spaces. 

        w= -[   D* + C    sqrt (10   |X|    / u) ]   
 
* The $s in the Excel version are optional right now but leave them in because they will be very useful 
soon. 
 
If everything works correctly when you change B11 from -2000 to -1000 the value of C11 goes from 
 –4.7 km to –4.05 km. 
 
When you change B11 from -2000 to -200 the value of c11 becomes _____________? 
 
 The above is great because we have created a calculator that allows us to put any horizontal 
distance value (X) into cell B11 and have Excel evaluate the ocean depth for that value of X and display 
it in cell C11.  We can also change the values of D*, C, and/or U by entering new values in c6, c7, or c8.  
This is a very handy tool for evaluating different equations.  The advantage of this over a calculator is 
that once the formula is typed in correctly it can be used over and over again.  Another advantage is that 
if you type in the formula incorrectly you don’t have to start all over to fix it but can simply edit it in the 
formula bar. 
 
Part 3.  Doing multiple calculations in Excel and Graphing the results. (assumes that you’ve done part 
2) 
 
Part 3a. Making a table of values from an equation 
It gets even better!   We can use what we have to make a table of horizontal distance (X) values and the 
corresponding depths to the ocean floor using what we already have.  This will make it easy to graph our 
results to help us visualize the behavior of this equation over a large range of horizontal distances. 
 
The first step is to generate a bunch of equally spaced X distances between –2000 km and +2000 km.   
        Enter: 
 B11:  -2000   (you should change it back to zero if you had change B11 to something else while testing ) 
 B12:  -1800 
   ° 
   ° 
 B31:  2000 
 
 WAIT!! 
You can do this an easy way or a hard way. 
 
1) The hard way is to enter each number into each cell one at a time. 
2) The easy way is to enter: 
 B11:  -2000    
 B12:  = B11 + 200  
Select cells B12  through  B31 (highlight them with the mouse by clicking and dragging) 
Use the Edit- Fill- Down command from the Edit file menu at the top of the Worksheet 
 
Note:  You can select the Edit -Fill -Down command by going to the Edit Menu drag down to Fill and 
select Down or by pressing the [CTRL] and D keys simultaneously.  Another easy way to fill down the 
equation written in cell B12 is to type it into B12 and press [R].  Then carefully move the mouse pointer 
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to the lower right corner of cell B12 and when the pointer changes to a solid pointer you can click and 
then drag it down to cell B31.  This automatically fills the cells B13 to B31 with the B12 formula.  Try it 
it’s fun. 
 
Click on cell B13 and let’s take a look at it more closely.   
 
Notice that when we used the Edit -Fill -Down command the equation that is in cell B12 (= B11 + 200) 
is copied into cell B13 as (= B12 + 200) [the value in cell B13 is 1600 but in the formula bar at the top 
you see the actual equation].  The cell assignment is relative as the equation is copied.  Another way of 
looking at it is that the equation in B12 can be read as, add 200 to the cell above this location and make 
that the value of this cell.  In cell B12, B11 is a relative cell reference .  We will describe fixed cell 
references, which are also useful, below. 
 

 
 
Let’s enter the equation for the ocean depth for horizontal positions between –2000 km to +2000 km 
from the MAR into cells C12 through C31.  Do this by copying (Fill Down) the formula in cell C11 to 
cells C12 through C31.  Select cells C11 - C31 and use the Edit Fill Down command.  That's all there is 
to it!!   
 
Select cell C12.  Notice the $ in front of the row or column label fixes the row or column (or both) so 
that when the formula is copied the fixed cell reference does not change.  This is a fixed cell reference.  
Depending on what you want to do, both variable and fixed cell references are very useful.  The c$6 
reference will always go to row 6 of whatever column you’re in.  Whereas the $b11 reference will 
always go to column B of whatever row you’re in (the row will be relative).  Click on C12 
                        C12 has =  -  ( c$6  + c$7* sqrt (10 *abs($B12)  /  c$8) )[ [in formula bar] 
 
Remember       [C11:  -  ( c$6 + c$7*sqrt (10 *abs($B11) / c$8) )] 
 
That's all there is to it!!  For each X value in column B a Depth value is calculated in column C . 
(Info alert:  upper and lower case letters both work the same in formula cell references). 
 
Cells C11 - C31 now contain the depth of the ocean floor for 200 km horizontal distance intervals 
between –2000 km and +2000 km. 
 
The worksheet is now in good shape. Resave it using the File Save command or by clicking on the disk 
icon of the tool bar.  You should resave your work frequently , even before the final version is 
complete.  This could save you from turning a good day into a bad day if for some reason the computer 
crashed or (heaven forbid) the operator made a careless error. 
 
This would be a good time to use the Edit-Move or Copy Sheet-Create copy command and then resave 
the whole worksheet again.  This will give you two sheets of what you just created so you can modify 
one of them following the instructions in Part 3b and not worry about losing what you already have.  
 
 

        
Part 3b.  One of the nicest features of Excel is that you can easily make a graph of your results.  
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To make a graph  of the ocean depth (c11 - c31) on the y-axis versus distance (b11-b31) on the x-axis*: 
— Select cells B11 through C31 (2 columns) 
— Click on the chart wizard icon  
* The x-axis values are always in the first column on the left
     

 
¾ Select XY scatter and select the type of x-y scatter plot you want (click Next) 
¾ Excel usually knows that you are using columns for x and y data ( click next) 
¾ You can enter the title and axes labels here. Click on the Legends tab and uncheck the check 

box.  Click on the other tabs to see what they can do.  You can come back here later if you want 
to change your graph a bit. ** [click Next]  

¾ You can save the chart as a separate page or as an object on your working spreadsheet.  The save 
as object choice keeps numerical values and the graph together which is often nice. Choose save 
as object. [click finish] 

 
**If you want to modify your graph after finishing it use Chart Options of the Chart menu.  To get the 
Chart menu you have to first finish the graph and then click somewhere on it to select the whole graph. 
 
The chart you have created is part of the worksheet.  To select the chart itself so that you can modify it 
or print just it, mouse click anywhere in the chart.  Do this now.  If the legend box is still there click on 
it and hit the delete key.  With the whole chart selected you can change the font size, style, etc. with the 
format menu or you can select any part of the chart to reformat only it.  Playing around in the Excel 
environment and sharing what you find out with family and friends is the best way to learn Excel more 
completely.   
  
You can move the chart window to a new position to make both the table and graph  clearly visible. 
 
Locate the mouse pointer inside the chart, press and hold the mouse button, and drag the window to its 
new position.  TRY THIS! 
 
Move the chart window to the right side of the monitor screen so it and columns B and C can be seen. 
 
You can change the size of the chart window by pointing on a corner of the window and dragging this 
corner to its new position.  TRY THIS!   
 
Let's add some labels to the axes and a title to the graph.  If you already added these when you first 
made your chart follow the instructions here anyway so you will learn how to edit your titles and labels. 
 
Use the Chart Options of the Chart menu to edit or add title, legend, etc. 
 — For the x-axis label use: Horizontal Distance from MAR (km) 
 

— For the y-axis label use: Ocean Depth (km) 
 
— Make up your own title. 

 
— Play around with the other tab items in the Chart Options section to see what they can do.  

After you finish click okay. 
 

— To edit the font use for the whole graph click just inside the outside edge of the graph and 
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then Selected Chart Area from Format menu. This gives you options for fonts (among 
other things).  Click on an individual axis title and then use Selected axis title from 
Format menu to change the font for only that axis. 

  
 — Click on the y-axis to select it.  With the y-axis selected, use the Format - Selected axis -

Scale tab to set the minimum y value to -5.00 and the maximum to 0.0.  Doing this 
manually fixes the scale of the graph so that when you make changes in the input data the 
scale doesn't change.  This makes it easier to see exactly what changes occur in the 
graph's appearance for a given input change.  If the scale did change the true changes in 
the graph's appearance would be disguised somewhat.  In the same way change the scale 
for the x-axis to from -2000.0 to 2000.0. 

 
— Resave your worksheet by using the File -Save command.   

 
— Carefully sketch your graph of Ocean Depth versus X distance on the axes provided 

below.  Label both axes, include units, and title the graph.  Call this graph 1 
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With the worksheet selected, change the spreading rate, U, (cell C8) from 50 km/Myr to 100 km/Myr. 
 
Reselect the chart and sketch it on the same set of axes as above.  Use a different color or line type to 
clearly and unambiguously distinguish your two curves and use a legend to the right of your graph 
above to indicate which line is which.  Call this graph 2 

 
With the worksheet selected, change U (cell C8) from 100 km/Myr to 200 km/Myr.  Sketch this on the   
same set of axes and  make sure that this line is clearly labeled.  Call this graph 3 
 
Let’s use Excel to check your answer for the sketch above and put three lines on one set of axes.  This is 
pretty easy to do.   
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Select cells C6 through C31 [highlight these cells], copy them with [Edit-Copy-command]or [Ctrl][C], 
and then select cell D6 and paste with [Edit –Paste command]or [Ctrl][V].  Select cell E6 and Paste 
again.  Because of the fixed and relative references used, X distances are always in column B and D*, C 
, and U for each column depth calculation are in either C6-C8, D6-D8, or E6-E8 respectively. 
Cell D11 has the formula 
= - ( D$6 + D$7*sqrt (10 *abs($B11) / D$8)) 
and E11 
= -  ( e$6 + e$7*sqrt (10 *abs($B11) / e$8) ) 
Changing C6 –C8 to (2.5, 0.11, 50) will give you numbers in column C for graph 1 above  
 
Changing D6 –D8 to (2.5, 0.11, 100) will give you numbers in column D for graph 2 above  
and 
Changing E6 –E8 to (2.5, 0.11, 200) will give you numbers in column E for graph 3 above  
 
To add a new line to the chart, select the chart and go to Chart-Add data menu item and when asked for 
the range select D11-D31 on the worksheet by clicking and dragging with the mouse. 
 
Repeat for your third line E11-E31. 
 
Remember, you can force the x-axis to go from -2000 to 2000 second by clicking on it and go to the 
Format-Selected axis-Scale command and type in the min & max values of this axis.  The same 
technique that we used before to force the y-axis to go from -5.00 to 0.00. 
 
With 3 lines on one graph you may want a legend to help identify.  Chart –Chart Options -Legend tab 
and select Add Legend.    Then name each series by Chart-Source Data-Series. 
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The ocean surface with sailboat was added with the drawing tool.  Can you find it on the tool bar? 
 
 By now you probably feel like you're in Excel heaven.  With this fabulous tool, the 
spreadsheet, you can easily see what happens to the theoretical shape of the ocean floor for different 
assumed spreading rates.  For numerical answers to specific questions, it's sometimes easiest to read the 
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values right off the worksheet.  This may involve using the scroll bars at the right side or bottom of the 
worksheet.  To see how they work, 
 
 — Click below the square box in the scroll bar on the right. 
 — Next drag the square box a little to see what happens. 
 — Finally, point (and click) to the arrows at the top or bottom of the scroll bar to see how 

this works. 
 

— Play with the bottom scroll bar a little. 
 
Questions (turn-in):  How does an increase in sea floor spreading rate U influence: 
  The steepness of the MAR walls? 
 
  The depth of the ocean far from the ridge (or the height of the ridge above the 
background ocean)? 
 
  In terms of the physical processes linked to MAR formation, explain why the above 
answers make sense. 
 
 
 
 
 
 
 
 
 
Graphs (turn-in):  After you get your graph of ocean depth for the three different spreading rate in 
good shape print it out and turn it in. 
 
 
 
 
 
 
Use the Edit-Move or Copy Sheet-Create copy command and then resave the whole worksheet.   This 
will give you two sheets of what you just created so you can modify one of them following the 
instructions below without losing what you just did. 
 
 
 
On your new sheet change all U values (C8, D8, and E8) back to 50 so that all three graphs are identical.  
Let’s now look at the C value in our equation more closely.   
 
 
 
In the derivation of our equation**, C is related to mantle density (ρm), mantle temperature (Tm ), ocean 
density (ρo=1.0 g/cc),  and ocean temperature (To=280 K) by 
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The ocean density and temperature are known fairly well and so do not change.  Increase the mantle 
density by 30%  from 3.3 to 3.3*1.3=4.3 g/cc and calculate a new value of C with a calculator or within 
an Excel cell off to the side.  Put this value for the C value of column D (cell D7) and if all works 
correctly your graph will be automatically updated.  Increase the mantle Temperature by 30%  from 
1580 K to 1580*1.3=2050 K and calculate a new value of C with a calculator or within an Excel cell off 
to the side.  Put this value for the C value of column E (cell E7) and if all works correctly your graph 
will be automatically updated.   ** The interested reader is referred to  
http://topex.ucsd.edu/geodynamics/07cooling.pdf for details. 
  
Re-label the legend and print this graph out to turn in. 
 
Questions (turn-in):  According to the mathematical formula (or model) how does the height of the 
ridge (height above the deepest ocean far from the ridge) change: 
  When the mantle density increases? 
 
 When the mantle temperature increases? 
 
Is the ocean depth profile strongly dependent on assumed mantle density? 
 
Is the ocean depth profile strongly dependent on assumed mantle temperature? 
 
In terms of the physical processes linked to MAR formation, explain why the above answers make 
sense. 
 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
Final Notes and miscellaneous about Excel: 
 
 [Ctrl] [Z] is the Edit-Undo command and can save you head aches when you accidentally type the 
wrong thing.   

http://topex.ucsd.edu/geodynamics/07cooling.pdf
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Also the escape key (Esc) will get you out of a cell without making changes if you are typing something 
in and you know it’s not right. 
 
If you are in cell B12 and have typed =0.1+   you can make it =0.1+B11 by clicking on the cell B11.  
This is a bit of a time saver but this feature tends to work as it should at unexpected times and is a good 
reason to remember the esc key trick. 
 
Double clicking on a line or the background or specific text brings up dialog boxes that allow you to 
change color, font type, line thickness,….. 
 
All sorts of mathematical functions can be used click on fx tool bar item of Insert-function command to 
see what the possibilities are. 
 
An automatic Sum of values can be obtained by clicking on the S tool bar item.  Look carefully when 
using this to make sure it guessed which cells you wanted to sum correctly.  If not simple edit to the 
correct value in the formula bar. 
 
In addition to the mouse, the error keys on your key board can also help you move around within the 
spreadsheet. 
 
Good Luck and have fun. 
 
 
Save this activity so you can find it again later.  
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